## Table of Contents

**Overview** ...................................................................................................................................................... 4  
Who uses document management? .................................................................................................................... 4  
Document management roles ............................................................................................................................ 4  
Basic procedures ............................................................................................................................................... 5  
  * Add a document to version control .............................................................................................................. 5  
  * Check out a document ............................................................................................................................... 5  
  * Check in a document ................................................................................................................................. 5  
  * Undo a document checkout ....................................................................................................................... 6  
  * Mark a document as private ..................................................................................................................... 6  
Less common procedures .................................................................................................................................... 6  
  * Remove a document from version control .............................................................................................. 7  
  * Set the default location for version control ............................................................................................ 7  
  * View version control document properties ............................................................................................ 7  
Working with earlier versions of a document ..................................................................................................... 8  
  * View history on a document in version control ....................................................................................... 8  
  * View an earlier version of a document .................................................................................................... 8  
  * Promote a document in version control .................................................................................................. 8  
**Digital Signatures** ............................................................................................................................................. 9  
Overview............................................................................................................................................................ 9  
Security ............................................................................................................................................................ 9  
  * Printing or exporting documents ............................................................................................................... 10  
  * Signature representations ....................................................................................................................... 10  
  * Identifying signed documents ............................................................................................................... 10  
  * Version control ...................................................................................................................................... 10  
  * Searching ............................................................................................................................................. 10  
Getting started with digital signatures ............................................................................................................. 10  
Basic procedures .............................................................................................................................................. 11  
  * Sign a document ................................................................................................................................. 11  
  * Move a signature representation .............................................................................................................. 11  
  * View a digital signature ......................................................................................................................... 12  
  * View a signed version of a document ..................................................................................................... 12  
  * Show or hide a digital signature representation .................................................................................... 12  
Less common procedures .................................................................................................................................... 12  
  * View history of a signature ..................................................................................................................... 13  
  * Void a digital signature ............................................................................................................................ 13
Delete a digital signature representation ............................................................................................. 13
Delete a signed document .................................................................................................................... 13
Search for documents based on digital signature status ................................................................. 13
Verify digital signatures .................................................................................................................... 14
Set password entry frequency .......................................................................................................... 14
Set digital signature time out .............................................................................................................. 14
Administer digital signature privilege settings .................................................................................. 15
Append signature reports to printed or exported documents .............................................................. 16
Automatically verify signatures ........................................................................................................ 16

Digital IDs ............................................................................................................................................... 17
Basic Procedures .................................................................................................................................. 17
Set Digital ID expiration period ........................................................................................................... 17
Expire or void a Digital ID .................................................................................................................... 17

Reference .............................................................................................................................................. 19
Version Control toolbar ....................................................................................................................... 19
Version control security privileges ..................................................................................................... 20
Digital signature security privileges ..................................................................................................... 21
Digital signature status indicators ....................................................................................................... 22

Index ...................................................................................................................................................... 23
Overview

ImageNow document management, also known as library services or version control, gives ImageNow Client and WebNow Client users the ability to manage changes to a document by individual or multiple authors while preserving previous versions of the document each time changes are made.

Who uses document management?

The answer depends on how a person or team needs to track a changing document. Here is a scenario that would typically occur at a law firm. After opening a contract template, Jody, a legal assistant, creates and saves a preliminary draft of a new contract and then adds the draft to ImageNow version control. In doing this, Jody also automatically adds the file and any document key values, such as drawer, folder, and custom properties that she wants to use as an aid to herself or others when searching for the document to the ImageNow repository. When the document is in version control, only Jody or one of the legal staff members who share her access privileges can modify the document by checking it out.

What happens when Stan, an attorney in the office, checks out the document that Jody drafted? First, other ImageNow users, including Jody, are prevented from checking the document out at the same time, which achieves one of the main goals of document management. It prevents the distribution of multiple copies of a document, each of which acquires a different set of changes. With version control, only the user who checks out a document can make changes to it, although other users can still view the last checked-in version of the document. To continue with the example, Stan saves the document he is updating to a local folder. He makes his changes, saves the file, and then checks it back in to version control.

What happens when Stan checks in the document? First, a new version of the document is saved in the ImageNow repository. If the previous document was version 1, the current document becomes version 2. Second, Stan can opt to delete the local copy of the document on his computer so that, during the revision process, he doesn't accumulate a set of non-current versions of the contract. Third, the updated document in ImageNow can be viewed by other users. If one of them needs to make changes to the document, he or she can now check it out. However, Stan may not want other users to edit or even view the new version yet. Therefore, when checking in the document, he can mark the version private to keep it from being opened by other users (although managers can still view the document).

Document management offers the additional advantage of allowing users to approve the current version of any document using a unique digital signature. The digital signature feature is introduced in the second part of this guide.

To use ImageNow document management features, you must have a dedicated document management license. Contact your Perceptive Software representative for details about how to obtain document management licenses and upload them.

Document management roles

ImageNow users assume one the following roles in document management:

Manager (or owner) – The role of ImageNow manager in document management allows you to grant and deny library service privileges and digital signature privileges to users. A manager can also view document versions marked private. For simplicity, when this guide refers to a manager, it may be taken to mean manager or owner. For digital signatures, the manager may also update reasons and reason lists. For more information about reasons and reason lists, refer to the information provided on the Perceptive Software website, in the Customer Portal, under Product Documentation. For complete descriptions of the document management and digital signature security privileges, refer to the “Reference” section of this guide.

ImageNow or WebNow Client User – In document management, this user adds documents to version control. To update documents in version control, this user checks them out, makes changes to the documents, and checks them back in. This role can also perform actions such as undoing a check out,
removing a document from versions control (sometimes required when merging documents), or promoting a previous version of a document to the current version.

**Basic procedures**

The following sections explain how to add a document to version control, check the document out for editing, check the document in, undo a document check out, and mark a document as private.

**Add a document to version control**

Before you can check a document in or out, you must first add its source file to ImageNow version control.

1. In **ImageNow Explorer**, right-click the document, point to **Version Control**, and then click **Add**.
2. In the **Add to Version Control** dialog box, type a comment, click the **More** button to verify that the **Mark as private** check box is clear, and then click **OK**.
3. Optional. To view version control options for a document, on the **View** menu, click **Actions** from **ImageNow Viewer**.

**Check out a document**

Before you can make changes to a document in version control, you must check it out. When you check out a document with digital signatures and then check the document in, the updated document you check in does not inherit the digital signatures from the previous version.

1. In **ImageNow Explorer**, right-click the document, point to **Version Control**, and then click **Check Out**.
2. In the **Check Out** dialog box, add any comments.
3. If you want ImageNow to save a copy on your local file system, select **Edit locally** and then browse to a local folder.
4. Click **OK**.

**Tip** To check out a document from **ImageNow Viewer**, in the **Version Control** toolbar, click the **Check Out** button

**Check in a document**

After checking out a document, you must check it in to save your changes in the ImageNow repository. Checking a document in creates a new version of the document while preserving previous versions. When you check in a document that previously had digital signatures, note that the updated document you check in does not inherit the digital signatures.

1. In **ImageNow Explorer**, select the document you want to check in.
2. On the **File** menu, point to **Version Control**, and then click **Check In**.
3. In the **Check In** dialog box, add any comments.
   - If you made changes to the copy of the document saved on your local computer in its native application, click **More** and verify the **Filename** of the local copy.
   - If you want to remove the copy of the document that was saved on your local computer, click **More** and select the **Delete local copy** check box.
   - If you want to save your changes on ImageNow and keep the document checked out (for example, to continue editing it), click **More** and select the **Keep checked out** check box.
   - If you want to check the document in but prevent other users from opening it, click **More** and select the **Mark as private** check box.

4. Click **OK**.

**Tip** To check in a document from **ImageNow Viewer**, in the **Version Control** toolbar, click the **Check In** button

**Undo a document checkout**

If, after checking out a document, you decide to cancel that action and not make a new version, you can undo the check out. If you undo the check out, any changes you made to the document after checking it out are lost.

1. In **ImageNow Viewer**, if the **Actions** pane is not visible, on the **View** menu, click **Actions**.
2. With your document open in the **ImageNow Viewer** and checked out, in the **Actions** pane, under **Version Control**, click **Undo check out**.
3. In the **Undo Check Out** dialog box, if you created a local copy and want to delete it now, select the **Delete local copy** check box.
4. Click **OK**.

**Tip** To undo a checkout from **ImageNow Viewer**, in the **Version Control** toolbar, click the **Undo Check Out** button

**Mark a document as private**

By marking a document private, only you can view and work on it. Other users can still see the document as a row in the search results grid, but they cannot view or edit it. Before starting this procedure, your document must be checked out to you.

1. With your document in a checked-out state and selected, in **ImageNow Viewer** or **ImageNow Explorer**, on the **File** menu, point to **Version Control**, and then click **Check in**.
2. In the **Check in** dialog box, add comments, and then select the **Mark as private** check box.
3. Click **OK**. The version history reflects that you marked the document as private.

**Tip** To mark a document private after you have checked it in, right-click the document, point to **Version Control**, click **Version History**, and then in the **Document Properties** dialog box, select the latest version, and then select the **Version is private** check box.

**Less common procedures**

You use the following procedures less frequently than basic procedures. You need them when you decide to take a document out of version control, set the default location for editing checked-out documents, view version control document properties or history, view an earlier version of a document, or promote an earlier version to the current version.
Remove a document from version control

When you remove a document from version control, the document loses any digital signatures that were applied to the current version. The signatures do not reappear if you add the document to version control again. Use this procedure only if you no longer need to track versions of the document, or you don’t need to do further edits of the document, or you need to save disk space.

To remove a document from version control, you must have the Document Management - Remove from Version Control privilege.

1. From the ImageNow Explorer, double-click the document you want to remove from version control. ImageNow opens the document in ImageNow Viewer.
2. In the ImageNow Viewer, verify that this is the document you want to remove from version control.
3. On the View menu, click Actions.
4. In the Actions pane, under Version Control, click Remove from version control.
5. (For documents that don’t have a digital signature) In the Remove from version control dialog box, to retain the history on the document but still remove it from version control, leave the Retain version history check box selected, and then click OK. The version history is stored as a document property.

Set the default location for version control

ImageNow Interact saves a copy of any checked out document in a local folder while you make changes to it. You can have this copy automatically deleted during check in.

1. On the ImageNow toolbar, on the Settings menu, click Options and then, in the ImageNow Options dialog box, click Version Control in the left pane.
2. On the General tab, under Version Control, in the Default location box, browse to the directory you want to set as the default location where you edit checked-out documents.
3. Click OK until you return to the ImageNow toolbar.

View version control document properties

You can view all of the metadata of a document in version control by following these steps.

1. In ImageNow Explorer, double-click the document you want to inspect for document properties. ImageNow opens the document in ImageNow Viewer.
2. In ImageNow Viewer, in the Actions pane, under Version Control, click Version history.
3. In the Document Properties dialog box, in the left pane, do one of the following actions:
   • Click Document and view the information on the Document Keys, General, and Custom Properties tabs.
   • Under Document, click the page you want and view the information on the Page, Source, and Content tabs. (The Content tab appears only if your ImageNow Server is also running ImageNow Content Server.)
Working with earlier versions of a document

The following sections explain how to view the history of a document in version control and how to view or promote an earlier version of a document.

View history on a document in version control

The following procedure explains how to inspect the list of previous versions of a document in version control.

1. In ImageNow Explorer, double-click the document you want to inspect for version history. ImageNow opens the document in ImageNow Viewer.
2. If the Actions pane is not visible, on the View menu, click Actions.
3. In the ImageNow Viewer, in the Actions pane, under Version Control, click Version history.
4. In the Document Properties dialog box, on the Version tab, view the version history for that document.

View an earlier version of a document

When you need to inspect a previous version of a document in version control, follow the steps below.

1. In ImageNow Explorer, find the document whose versions you want to view.
2. Right-click the document, point to Version Control, and then click Version History.
3. In the Document Properties dialog box, on the Version tab, select the version of this document that you want to view and then click View.

Promote a document in version control

Promoting makes a copy of an earlier version of the document and adds it as the new current version. It does not remove the previous current version or the copied version from version history.

From ImageNow Explorer Search grid

1. In the results grid, right-click the document, point to Version Control, and then click Version History.
2. In the Document Properties dialog box, on the Version tab, select the version of this document that you want, and then click Promote.
3. In the Promoting Version dialog box, select the Keep new version checked out for edits check box if you want to edit the document, and then click Yes.

From ImageNow Viewer

1. If the Actions pane is not visible, on the View menu, click Actions.
2. With the past version of your document open in the ImageNow Viewer, in the Actions pane, click Promote.
3. If you want to edit the document, in the Promoting Version dialog box, select the Keep new version checked out for edits check box and then click Yes.
Digital Signatures

Digital signatures play an important role in moving your document processing from paper to electronic systems. Although you use digital signatures to electronically replace a handwritten signature, they are not images of handwritten signatures. A digital signature is usually a cryptographic signature. In ImageNow, the digital signature is calculated from the user’s Digital ID as well as from information derived from the signed document. To learn more about Digital IDs, refer to the “Digital IDs” section in this guide.

Digital signatures are legally binding as long as they meet the provisions outlined in the laws governing their use.

In ImageNow, digital signatures provide four benefits for documents:

- Authenticity, which provides proof of the identity of the individual who signs a document.
- Data integrity, which ensures that the document has not been altered by a third party outside of ImageNow.
- Non-repudiation, which prevents the signer of a document from later denying association with that document.
- Confidentiality, which ensures that data is only readable to the sender and the intended recipient, providing protection from third party snooping.

Overview

Digitally signing an ImageNow document requires that it be checked in to version control. Once signed, the document is made secure from alterations to the signed version. Signing a document entails entering a password, selecting a reason for the signature, and optionally placing one or more visual representations of the signature on the document. ImageNow automatically generates a Digital ID for the signing user if none exists. Otherwise, ImageNow uses the existing Digital ID to encrypt the digital signature.

After a document is digitally signed, any user who has privileges to view that document can verify the signature at any time. When a user opens a document, ImageNow automatically authenticates the signature against the stored hash value of the document that was generated at the time of signing.

Verifying a digitally signed document is a more thorough test than authentication and requires more processor time. Verification recalculates the document hash value and compares it with the signature to get real-time status. If the recalculated hash value matches the signature, the signature is validated; if the hash value does not match the signature (which could indicate tampering with the document outside of ImageNow), the signature is marked invalid.

Security

As an ImageNow manager, you designate which users and groups can access digital signature functionality. There are privileges for signing, voiding signatures, and deleting signed documents, as well as for moving and deleting signature representations. ImageNow managers also have options that include expiring and voiding Digital IDs, managing digital signature reasons, setting Digital ID validity periods, setting time out periods on signing sessions, and designating when users must enter their signing password.

When a manager sets a time-out period on a signing session, ImageNow closes the session of any user who has digitally signed a document but has not signed out within the designated time span. To review the signature status displayed for a document, refer to the “Digital signature status indicators” section of this document.
Printing or exporting documents

Users may be required to include a digital signature report when they print or export a signed version of a document. The report is included in the export only if the document is printed or exported in its entirety. It is appended as a separate page and contains the name of the signer, date signed, and reason for signing.

Signature representations

A document can have multiple valid signatures by a signer, and users can place as many visual representations of their signatures on the document as needed. However, visual representations can be placed only on images on which annotations are supported (TIFF, JPEG, and BMP).

Identifying signed documents

There are several ways to determine whether the current version of a document is signed.

- Whenever a signed document appears in the ImageNow Explorer grid, it is accompanied by a certificate 🌐 icon in the Digitally Signed column.
- A representation of the signature may appear on the document. A digital signature representation includes the name and user name of the signing user, date and time the document was signed, and the reason for signing the document.
- Digital signatures displayed in the Properties pane of a document include information identical to that in the visual representation.
- The signature status icon of the selected document appears at the right end of the ImageNow Viewer status bar.

Version control

When a user signs a document, it is automatically added to version control if it was not previously added. Because removing a document from version control removes the signature status but retains version history, signature operations can never be deleted.

Searching

Users can search for documents within any view to which they have access, based on the digital signature status of the documents. For example, a user can create a filter that returns only unsigned documents. Such searches can combine multiple constraints in a single filter, and so a user can also create a filter that returns both voided and invalid documents.

Getting started with digital signatures

Use the following high-level procedures to administer digital signatures in ImageNow. Each step in this outline refers to a specific procedure in the following sections.

1. Configure digital signature administration settings:
   - If necessary, create or modify reason lists for signing and voiding digital signatures.
   - If necessary, create or modify reason lists for expiring or voiding Digital IDs.
   - Set a default validity period for Digital IDs. Refer to the "Set Digital ID expiration period" section in this guide.
   - Configure digital signature reports. Refer to the "Append signature reports to printed or exported documents" section in this guide.
• Specify how often a user must enter the signing password. Refer to the "Set password entry frequency" section in this guide.
• Configure automatic verification of signatures, as necessary, within drawers or document types. Refer to the "Automatically verify signatures" section in this guide.

2. Assign security privileges for users and groups that use digital signatures. Refer to the "Administer digital signature privilege settings" section in this guide.

3. Configure management privileges for users administering digital signatures. For more information about privileges, refer to the information provided on the Perceptive Software website, in the Customer Portal, under Product Documentation.

Basic procedures

Sign a document
To perform this procedure, you must be a user with the Documents - Sign privilege, a manager, or the owner.

1. In ImageNow Explorer, double-click the document you want to sign. ImageNow opens the document in ImageNow Viewer.

2. Sign the document using one of these methods:
   • For documents that are TIFF, JPG, or BMP images, to sign the document and place a digital signature representation on the document image, on the Annotation toolbar, click the Digital Signature button. This places a representation on the document. You can then use the mouse to move the representation to any position on the document. If the Digital Signature icon is dimmed and unavailable, use the File menu to sign.
     
     Note  You can repeat this step to place additional representations on other parts of the document.
   
   • To sign documents that are not TIFF, JPG, or BMP or to sign any document without placing a digital signature representation on the document image, in the Actions pane, under Document, click Digitally sign this document or, on the File menu, click Digitally Sign.

3. If this is your first time signing a document, you are asked to create and confirm a password and enter your first and last name if these boxes are not already filled in.

   Note  You can also optionally create a password hint, which helps remind you of your password.

4. In the Digital Signature Authentication dialog box, in the Password box, enter your password. Depending on how your ImageNow implementation is set up, you may or may not have to enter a password each time you sign a document.

5. In the Reason list, select the reason you are signing this document and then click OK.

Move a signature representation
You can always move a signature representation to a different position on a document after adding the signature and before saving the document. To perform the move after the document has been saved, you must have the Move Signature Representations privilege. It applies only to signatures you have added.

1. Double-click the document to display it in ImageNow Viewer.

2. On the Annotations toolbar, click the Select Annotation tool.

3. Locate the signature representation and drag it to its new location on the document.
View a digital signature

The following procedure explains how to inspect the status (valid, expired, or void) of all digital signatures on a document.

1. Double-click the document to open it in ImageNow Viewer.
2. If the Digital Signatures pane is not visible, on the View menu, click Digital Signatures.
3. In the Digital Signatures pane, view the digital signature.

Note To review what the status indicators mean, refer to “Digital signature status indicators” in the “Reference” section of this document.

View a signed version of a document

Use the following procedure to display a signed version of a document in ImageNow Viewer.

1. In the results grid, right-click the document, point to Version Control and then click Version History.
2. In the Document Properties pane, in the left pane, open Version History and select the signed version of the document, which is accompanied by a digital signature icon. Depending on its history, there may be one signed version of the document or several signed versions.
3. Click View to open that version in the ImageNow Viewer.

Show or hide a digital signature representation

This procedure affects only the digital signature representations displayed within ImageNow Viewer.

- To hide all digital signature representations, in ImageNow Viewer, on the Annotations menu, click View and then clear the check box next to Digital Signatures.
- To show any hidden digital signature representations, in ImageNow Viewer, on the Annotations menu, click View and then select the check box next to Digital Signatures.

Less common procedures

The following digital signature procedures are less frequently used than basic procedures. They include:

- Viewing the history of a digital signature
- Voiding a signature
- Deleting a signature representation
- Deleting a signed document
- Searching for documents based on their digital signature status
- Verifying digital signatures
- Setting password entry frequency
- Setting digital signature time out
- Administering digital signature privilege settings
- Appending signature reports to printed or exported documents
- Automatically verifying signatures
View history of a signature

Use the following procedure to check the status of a specific digital signature.
1. Double-click the document to display it in ImageNow Viewer.
2. On the View menu, click Digital Signatures.
3. In the Digital Signatures pane, double-click the signature you want.
4. In the Digital Signatures dialog box, on the History tab, view the signature history.

Void a digital signature

To void any signature other than your own, you must be a user with the Documents - Void Signatures privilege, a manager, or the owner.
1. In the search results grid, double-click the document that contains the signature.
2. If the Digital Signatures pane is not visible, on the View menu, click Digital Signatures.
3. In the Digital Signatures pane, double-click the row that contains the digital signature you want to void.
4. In the Digital Signature dialog box, click Void, select a reason for voiding the digital signature, click OK, and then click Close.

Delete a digital signature representation

To perform this procedure, you must have the Delete Signature Representations privilege. It applies only to signature representations you have added. No user, manager, or owner can delete another user’s signature representations.
2. On the Annotations toolbar, click the Select Annotation tool.
3. On the document image, right-click the signature representation, click Delete, and then click Yes in the confirmation box.

Note Deleting a visual representation does not affect the signature status of the document. For more information, refer to the "Void a digital signature" section of this document.

Delete a signed document

To perform this procedure, you must be a user with Documents - Delete Signed Documents privilege and the Documents - Delete privilege for the document or be a manager or the owner.
- In the search results grid, right-click the document you want to delete, click Delete, and then click Yes in the confirmation box.

Search for documents based on digital signature status

To perform the following procedure, you must have the View - Access and View - Filter privileges for the documents you are searching.
2. In ImageNow Explorer, in the Views pane, under Documents, select the view that contains the documents you need to search.
3. In the Search tab, click the Add button.
4. In the Add Condition dialog box, in the Constrain By list, select Status.
5. In the Field list, select **Digital signature status**.
6. In the Operator list, select **is equal to** or **is not equal to**.
7. In the Value list, select **Valid**, **Invalid**, **Void**, or **Not signed**.
8. Add more conditions as necessary and then click **OK**.
9. Click the **Go** button.
10. Optional. To save this filter for future use, in the Filter toolbar, click the Save Filter button and then, in the Save Filter dialog box, name the filter, enter an optional description, and click **OK**.

**Verify digital signatures**

Verifying a signature ensures that a signed document has not been compromised by unauthorized activity outside of ImageNow.

1. Double-click the document you want to verify. ImageNow opens the document in **ImageNow Viewer**.
2. On the File menu, click **Properties**.
3. In the Document Properties dialog box, in the left pane, open **Version History** and click the version you want to verify.
4. On the Digital Signatures tab, do one of the following options:
   - To verify all signatures on the selected version, click **Verify All**.
   - To verify a single signature, double-click the item in the list, and then, in the Digital Signature dialog box, click **Verify**.

**Note** ImageNow displays a message indicating that the signatures have been verified as of the current date. In addition, the status indicator for each invalid signature changes to 🚨.

**Set password entry frequency**

To perform this procedure, you must be a user with digital signature management privileges, a manager, or the owner.

1. On the ImageNow toolbar, click **Manage**.
2. In the ImageNow Management Console window, in the left pane, click **Digital Signatures**.
3. On the Digital Signatures tab, under **Signing Password**, in the list, select how often users must enter a password when signing documents.

**Set digital signature time out**

To perform this procedure, you must be a user with digital signature management privileges, a manager, or the owner. The time-out feature requires a user who digitally signed a document, but who did not log out before the specified time out value, to re-enter his or her digital signature password. The feature does not close the ImageNow or WebNow client.

1. On the ImageNow toolbar, click **Manage**.
2. In the ImageNow Management Console window, in the left pane, click **Digital Signatures**.
3. On the Digital Signatures tab, under **Signing Password**, set the **Prompt user to enter password** option to **Once per session**.
4. In the **WebNow password time out** list, select the amount of time to elapse between the last digital signature activity and timing out (which requires the user to re-enter his or her digital signature password). The timeout value can range from Never (the default) to specific time values up to 60 minutes.

5. Repeat step 4 for the **ImageNow password time out** list, which can have a different value.

6. Close the ImageNow Management Console window

**Note** The time out applies globally to all digital signatures.

### Administer digital signature privilege settings

To perform these procedures, you must be a user with user or group management privileges, a manager, or the owner. These options apply globally to all digital signatures. For complete descriptions of the document management and digital signature security privileges, refer to the “Reference” section of this guide.

1. On the **ImageNow** toolbar, click **Manage**.
2. In the ImageNow Management Console window, in the left pane, click **Groups** or **Users**.
3. Select the **Security** tab, search for a user or group name and then click **Modify**.
4. On the **Security Settings** dialog box, do one or more of the following options:
   - **Assign Manage Digital Signatures privilege**
     1. In the **Security Settings** dialog box, click **Global Privileges**.
     2. In the **Privilege** list, under **Manage**, select the **Digital Signatures** privilege.
     3. Click in the column to the left of the privilege so that ✔️ is displayed to grant the privilege.
   - **Assign signature privileges at the Drawer level**
     1. Click **Drawer Privileges**.
     2. In the **Drawer** list, select the drawer to which you want to apply privileges.
     3. In the **Privilege** list, under **Documents**, do one or more of the following options:
        - To grant the **Sign**, **Delete Signed Documents**, **Void Signatures**, **Move Signature Representation**, or **Delete Signature Representation** privilege, click the column in front of the corresponding privilege until ✔️ appears.
        - To deny the **Sign**, **Delete Signed Documents**, **Void Signatures**, **Move Signature Representation**, or **Delete Signature Representation** privilege, click the column in front of the corresponding privilege until ✔️ appears.
   - **Assign signature privileges at the Document Type level**
     1. Click **Document Type Privileges**.
     2. In the **Document Type** list, select the document type to which you want to apply privileges.
3. In the **Privilege** list, under **Documents**, do one or more of the following options:

   - To grant the **Sign**, **Delete Signed Documents**, **Void Signatures**, **Move Signature Representation**, or **Delete Signature Representation** privilege, click the column in front of the corresponding privilege until ✅ appears.

   - To deny the **Sign**, **Delete Signed Documents**, **Void Signatures**, **Move Signature Representation**, or **Delete Signature Representation** privilege, click the column in front of the corresponding privilege until ✅ appears.

4. Click **OK** and close the Management Console window.

### Append signature reports to printed or exported documents

To perform this procedure, you must be a user with digital signature management privileges, a manager, or the owner. These options apply globally to all digital signatures.

1. On the **ImageNow** toolbar, click **Manage**.

2. In the ImageNow Management Console window, in the left pane, click **Digital Signatures** in the left pane.

3. On the **Digital Signatures** tab, under **Digital Signature Report**, select the **Include a Digital Signature report for all signed documents** check box to cause ImageNow to print a report whenever a user prints or exports a signed version of a document, or clear the check box to disable this option. When this check box is cleared, no report is printed.

4. In the **For each report, display** list, select an inclusion option for the reports: **Valid signatures only** or **All signatures**.


**Note** Digital signature reports are printed only when a document is printed in its entirety.

### Automatically verify signatures

You can apply automatic verification of signatures to all documents that have a common drawer or document type. Applying automatic verification of signatures to a large number of documents can occasionally slow performance of ImageNow Server.

1. On the **ImageNow** toolbar, click **Manage**.

2. In the ImageNow Management Console window, in the left pane, depending on which category of documents you want to affect, click **Drawers** or **Document Types**.

3. In the right pane, click the drawer or document type for which signatures will be automatically verified, and then click **Modify**.

4. Do one of the following options:

   - In the **Drawer** dialog box, on the **Digital Signatures** tab, select the **Automatically verify signatures for this drawer** check box.

   - In the **Document Type** dialog box, on the **Digital Signatures** tab, select the **Automatically verify signatures for this document type** check box.

5. To specify how often the signatures are verified, in the **Verification interval** boxes, select the number and time unit and then click **OK**.

6. Optional. Repeat steps 1-5 for any additional drawers or document types to which automatic signature verification must be applied.
Digital IDs

A Digital ID is a unique identifier created for your ImageNow user account but not displayable in ImageNow. ImageNow uses your Digital ID when creating and verifying digital signatures.

Digital IDs are automatically created by the ImageNow Server any time a user who does not have a Digital ID but who has the correct privileges requests to digitally sign an ImageNow document. The ImageNow administrator initiates digital signature actions only when expiring or voiding a Digital ID.

- You expire a Digital ID when you no longer want that digital ID used to sign documents. Any documents previously signed with that Digital ID are still valid.
- You void a Digital ID when you want not only to prevent further use of the Digital ID for signing documents but also to void all signatures created using that Digital ID, ensuring that they will no longer be legally binding. Voided signatures are indicated by ⚠.

Technical background

The digital signature functionality in ImageNow relies on public key infrastructure (PKI) using asymmetric cryptography. PKI is a secure method for exchanging information that includes a set of security policies and encryption methods that generate, store, exchange, and manage keys and digital certificates. Asymmetric cryptography is cryptography in which a pair of keys is used to encrypt and decrypt data. This pair of keys is known as a public-private key pair. These key pairs are called Digital IDs in ImageNow, and ImageNow Server automatically creates and manages these Digital IDs for you.

Basic Procedures

This section includes instructions for setting a Digital ID expiration period and expiring or voiding a Digital ID.

Set Digital ID expiration period

To perform this procedure, you must be a user with digital signature management privileges, a manager, or the owner. The procedure applies globally to all Digital IDs.

1. On the ImageNow toolbar, click Manage.
2. In the ImageNow Management Console window, in the left pane, click Digital Signatures.
4. If you selected Custom interval after creation date, in the Interval box, type or select the number of days for the expiration period.

Expire or void a Digital ID

To perform the following procedure, you must be an owner, a manager, or have the global Manage Users privilege. Voiding a Digital ID voids all signatures associated with that ID. If you only want to allow a user to create another Digital ID and re-enter his or her password information, expire the Digital ID.

1. On the ImageNow toolbar, click Manage.
2. In the ImageNow Management Console window, in the left pane, click Users.
3. In the right pane, on the User Profiles tab, search for the user you want and then click Modify.
4. In the Modify User Profile dialog box, click Digital ID.
5. Perform one of the following options:
   - **Expire a Digital ID**
     1. Select the Digital ID, and click **Expire**.
     2. In the **Expire Digital ID** dialog box, in the **Date** list, select the date on which to make the expiration effective.
     3. In the **Reason** list, select the reason for expiring the Digital ID and then click **OK**.
   - **Void a Digital ID**
     1. Select the Digital ID, and click **Void**.
     2. In the **Void Digital ID** dialog box, in the **Reason** list, select the reason for voiding the Digital ID, and then click **OK**.

   **Note** Depending on the number of signatures created with the Digital ID and the size of the document images, this procedure may require a long period of time for ImageNow Server to process.

6. When you are finished modifying Digital IDs, in the **Modify User Profile** dialog box, click **OK** and then close the ImageNow Management Console window.
Reference

This section contains document management-related information that you can reference when working with documents in version control. The following information is provided in this section:

- Version Control toolbar
- Version Control security privileges
- Digital signature security privileges
- Digital signature status indicators

Version Control toolbar

The Version Control toolbar is available in both the WebNow Explorer and WebNow Viewer. You can also use a right-click shortcut menu, action pane, or the standard File menu to access document management functions.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Check In</td>
<td>Check the item into version control.</td>
</tr>
<tr>
<td></td>
<td>Check Out</td>
<td>Check the item out of version control.</td>
</tr>
<tr>
<td></td>
<td>Undo Check Out</td>
<td>Cancel the check out of an item from version control.</td>
</tr>
<tr>
<td></td>
<td>Version History</td>
<td>Display the Document Properties dialog box with a Version History item in the left pane.</td>
</tr>
<tr>
<td></td>
<td>Remove from Version Control</td>
<td>Remove the selected item from version control (does not delete the document from the ImageNow repository).</td>
</tr>
</tbody>
</table>
## Version control security privileges

An owner or manager can assign the document management privileges shown below to a user or a group.

<table>
<thead>
<tr>
<th>Privilege Type</th>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Type</td>
<td>Use Library Services</td>
<td>Lets the user perform the following actions on any documents belonging to the document type selected in the Resource Manager: check in, check out, undo check out, add a document to version control, and view properties. This includes the option to promote a document to the current version.</td>
</tr>
<tr>
<td></td>
<td>Remove from Version Control</td>
<td>Lets the user remove a document from version control and optionally retain the version history for any document belonging to the document type selected in the Resource Manager.</td>
</tr>
<tr>
<td></td>
<td>Undo 3rd Party Check Out</td>
<td>Lets the user undo a check out on any document belonging to the document type selected in the Resource Manager, regardless of the user who checked the document out.</td>
</tr>
<tr>
<td></td>
<td>Delete History</td>
<td>Lets the user remove all history relating to any document belonging to the document type selected in the Resource Manager and which was once in version control.</td>
</tr>
<tr>
<td>Drawer</td>
<td>Use Library Services</td>
<td>Lets the user perform the following actions on any documents belonging to the drawer selected in the Resource Manager: check in, check out, undo check out, add a document to version control, and view properties. This includes the option to promote a document to the current version.</td>
</tr>
<tr>
<td></td>
<td>Remove from Version Control</td>
<td>Lets the user remove a document from version control and optionally retain the version history for any document belonging to the drawer selected in the Resource Manager.</td>
</tr>
<tr>
<td></td>
<td>Undo 3rd Party Check Out</td>
<td>Lets the user undo a check out on any document belonging to the drawer selected in the Resource Manager, regardless of the user who checked the document out.</td>
</tr>
<tr>
<td></td>
<td>Delete History</td>
<td>Lets the user remove all history relating to any document belonging to the drawer selected in the Resource Manager and which was once in version control.</td>
</tr>
</tbody>
</table>
Digital signature security privileges

An owner or manager can assign the digital signature privileges shown below to a user or a group.

<table>
<thead>
<tr>
<th>Privilege Type</th>
<th>Privilege Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global</td>
<td>Manage – Digital Signatures</td>
<td>Lets the user modify digital signature reasons and reason lists.</td>
</tr>
<tr>
<td></td>
<td>Documents – Sign</td>
<td>Lets the user digitally sign any document that belongs to the document type selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Void Signatures</td>
<td>Lets the user void signatures on any document that belongs to the document type selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Delete Signed Documents</td>
<td>Lets the user delete any document that belongs to the document type selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Move Signature</td>
<td>Lets the user move that user’s signature representations to different positions on any document that belongs to the document type selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Representations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Documents – Delete Signature</td>
<td>Lets the user delete that user’s signature representations from any document that belongs to the document type selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Representations</td>
<td></td>
</tr>
<tr>
<td>Document Type</td>
<td>Documents – Sign</td>
<td>Lets the user digitally sign any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Void Signatures</td>
<td>Lets the user void signatures on any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Delete Signed Documents</td>
<td>Lets the user delete any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Move Signature</td>
<td>Lets the user move that user’s signature representations to different positions on any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Representations</td>
<td></td>
</tr>
<tr>
<td>Drawer</td>
<td>Documents – Sign</td>
<td>Lets the user digitally sign any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Void Signatures</td>
<td>Lets the user void signatures on any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Delete Signed Documents</td>
<td>Lets the user delete any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Documents – Move Signature</td>
<td>Lets the user move that user’s signature representations to different positions on any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
<tr>
<td></td>
<td>Representations</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Documents – Delete Signature</td>
<td>Lets the user delete that user’s signature representations from any document that belongs to the drawer selected in the Resources Manager.</td>
</tr>
</tbody>
</table>
Digital signature status indicators

Any document that contains a digital signature, either in its current version or in a previous version, is accompanied by a status indicator in the ImageNow Explorer grid in the Digitally Signed column. If your view does not show this column, you can temporarily display it by clicking the Columns button and selecting the Signature Status check box, or you can add the column in a private filter.

<table>
<thead>
<tr>
<th>Status Indicator</th>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[No icon]</td>
<td>none</td>
<td>The document has not been signed.</td>
</tr>
<tr>
<td>🟢</td>
<td>Valid</td>
<td>This signature has been validated.</td>
</tr>
<tr>
<td>🔴</td>
<td>Invalid</td>
<td>This signature is no longer valid because the document has been corrupted or compromised by changes made outside of ImageNow. To determine whether any signature is invalid, ImageNow verifies all signatures on a document when the user opens it or verifies signatures manually or automatically.</td>
</tr>
<tr>
<td>🔴</td>
<td>Voided</td>
<td>This signature has been voided either because the signer has voided the signature or because a user with the Void Signature privilege has voided the signature.</td>
</tr>
<tr>
<td>🔴</td>
<td>Previously Signed</td>
<td>Previous versions of this document are signed.</td>
</tr>
</tbody>
</table>

If a document contains multiple signatures, only one icon appears, according to the following precedence rules:

- If any signature in the list is invalid, the invalid icon is shown.
- If the document contains at least one valid signature and no invalid signatures, the valid icon is shown.
- If the document contains only voided signatures, the voided icon is shown.

The indicators also appear in the following locations:

- At the right end of the ImageNow Viewer status bar.
- In the Digital Signatures pane of ImageNow Viewer

In a representation on the document (if the file type of the document permits annotations).
<table>
<thead>
<tr>
<th>Index</th>
</tr>
</thead>
<tbody>
<tr>
<td>check out, undoing ................................................. 6</td>
</tr>
<tr>
<td>checking in a document ........................................... 5</td>
</tr>
<tr>
<td>checking out a document ......................................... 5</td>
</tr>
<tr>
<td>default edit location, setting for version control .............................................. 7</td>
</tr>
<tr>
<td>Delete Signature Representation privilege ...................................................... 15</td>
</tr>
<tr>
<td>deleting</td>
</tr>
<tr>
<td>Signature Representations privilege .................................................................. 15</td>
</tr>
<tr>
<td>Signed Document privilege ........................................................................... 15</td>
</tr>
<tr>
<td>Digital ID</td>
</tr>
<tr>
<td>administering ........................................................................ 17</td>
</tr>
<tr>
<td>expiring ............................................................................... 17</td>
</tr>
<tr>
<td>overview .............................................................................. 17</td>
</tr>
<tr>
<td>voiding ..................................................................................... 17</td>
</tr>
<tr>
<td>digital signature privilege settings .................................................................. 15</td>
</tr>
<tr>
<td>digital signature representation, moving ................................................................. 11</td>
</tr>
<tr>
<td>digital signatures</td>
</tr>
<tr>
<td>assigning privileges ................................................................................ 15</td>
</tr>
<tr>
<td>deleting a signed document .............................................................................. 13</td>
</tr>
<tr>
<td>Digital ID .............................................................. 17</td>
</tr>
<tr>
<td>overview ............................................................................... 9</td>
</tr>
<tr>
<td>password ..................................................................................... 17</td>
</tr>
<tr>
<td>printing reports ................................................................. 16</td>
</tr>
<tr>
<td>searching documents based on signature status ................................................................ 13</td>
</tr>
<tr>
<td>set expiration period .................................................................................. 13</td>
</tr>
<tr>
<td>setting a time out value ................................................................................. 14</td>
</tr>
<tr>
<td>signing a document ............................................................................. 11</td>
</tr>
<tr>
<td>verifying ...................................................................................... 14</td>
</tr>
<tr>
<td>viewing ......................................................................................... 14</td>
</tr>
<tr>
<td>viewing a signed document ........................................................................... 12</td>
</tr>
<tr>
<td>viewing history ................................................................................ 12</td>
</tr>
<tr>
<td>voiding ......................................................................................... 13</td>
</tr>
<tr>
<td>document management roles ...................................................................... 4</td>
</tr>
<tr>
<td>document properties, viewing ........................................................................ 7</td>
</tr>
<tr>
<td>documents</td>
</tr>
<tr>
<td>adding to version control .............................................................................. 5</td>
</tr>
<tr>
<td>checking in ...................................................................................... 5</td>
</tr>
<tr>
<td>checking out ..................................................................................... 5</td>
</tr>
<tr>
<td>marking as private ............................................................................... 6</td>
</tr>
<tr>
<td>promoting to current version ..................................................................... 8</td>
</tr>
<tr>
<td>viewing a signed version ....................................................................... 12</td>
</tr>
<tr>
<td>earlier versions of documents, viewing ................................................................... 8</td>
</tr>
<tr>
<td>expiring a Digital ID .......................................................................... 17</td>
</tr>
<tr>
<td>history, version ............................................................................. 8</td>
</tr>
<tr>
<td>icons, signature status ........................................................................... 22</td>
</tr>
<tr>
<td>indicators of signature status ................................................................ 22</td>
</tr>
<tr>
<td>Invalid status ................................................................................. 22</td>
</tr>
<tr>
<td>Manage Digital Signatures privilege .................................................................. 15</td>
</tr>
<tr>
<td>Move Signature Representations privilege ................................................................ 15</td>
</tr>
<tr>
<td>password for digital signature ..................................................................... 17</td>
</tr>
<tr>
<td>setting entry frequency ........................................................................ 14</td>
</tr>
<tr>
<td>Previously Signed status ................................................................................ 22</td>
</tr>
<tr>
<td>private documents ................................................................................. 6</td>
</tr>
<tr>
<td>privilege settings ................................................................................ 15</td>
</tr>
<tr>
<td>privileges ......................................................................................... 15</td>
</tr>
<tr>
<td>promoting documents ............................................................................. 8</td>
</tr>
<tr>
<td>removing documents from version control ................................................................ 7</td>
</tr>
<tr>
<td>reports, digital signature ........................................................................ 16</td>
</tr>
<tr>
<td>roles, document management ........................................................................ 4</td>
</tr>
<tr>
<td>searching for documents based on signature status ................................................. 13</td>
</tr>
<tr>
<td>security privileges ............................................................................... 20</td>
</tr>
<tr>
<td>Sign privilege ...................................................................................... 15</td>
</tr>
<tr>
<td>signature privilege, assigning ........................................................................ 15</td>
</tr>
<tr>
<td>signature representation, moving ................................................................... 11</td>
</tr>
<tr>
<td>signed version of a document, viewing ................................................................... 12</td>
</tr>
<tr>
<td>status indicators, digital signatures ................................................................ 22</td>
</tr>
<tr>
<td>timing out a digital signature session ................................................................ 14</td>
</tr>
<tr>
<td>toolbar, Version Control ........................................................................... 19</td>
</tr>
<tr>
<td>undoing a check out ............................................................................... 6</td>
</tr>
<tr>
<td>Valid status ......................................................................................... 22</td>
</tr>
<tr>
<td>verifying digital signatures ...................................................................... 14, 16</td>
</tr>
<tr>
<td>version control</td>
</tr>
<tr>
<td>adding documents to ............................................................................ 5</td>
</tr>
<tr>
<td>Topic</td>
</tr>
<tr>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>removing documents from</td>
</tr>
<tr>
<td>security privileges</td>
</tr>
<tr>
<td>setting default edit location</td>
</tr>
<tr>
<td>toolbar</td>
</tr>
<tr>
<td>viewing history of digital signatures</td>
</tr>
<tr>
<td>version control, adding documents to</td>
</tr>
<tr>
<td>version history, viewing</td>
</tr>
<tr>
<td>Voided status</td>
</tr>
<tr>
<td>voiding a Digital ID</td>
</tr>
</tbody>
</table>